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In this guide, you’ll find general information about how Outlook 2007
and SharePoint Server 2007 work together. These products offer the 
ability to use Outlook 2007 to view and edit SharePoint Server 2007

Resource Description

Calendar Use calendars to schedule projects, appointments, 
and milestones. A SharePoint Server 2007 calendar 
can be viewed side by side with an Outlook 2007ability to use Outlook 2007 to view and edit SharePoint Server 2007 

collaboration resources.

Outlook 2007 and SharePoint Server 2007  
Together

can be viewed side-by-side with an Outlook 2007 
calendar, or the two calendars can be overlaid to 
view all items at once. You can drag an item to your 
Outlook 2007 personal calendar to see it on a mobile 
device.

Task List Use task lists to assign project duties and track them Together
In SharePoint Server 2007, you can create resources for team collaboration 
and then connect them to Outlook 2007 so that team members can 
collaborate with them there. 

Because of this connectivity, you can stay in the familiar environment of 
Outlook 2007 and work directly on SharePoint Server 2007 resources. You 

to conclusion. Team members can see all project 
tasks in the Tasks window, or can view tasks 
assigned only to them in the To-Do Bar.

Document 
Library

Team members use document libraries to preview, 
search, and open project documents. Site members 
can edit documents locally or offline. Office reminds y

can even work on the resources offline, because your changes will be 
synchronized when you go online. This way, you can work no matter what 
your connection status is.

SharePoint Server 2007 resources refers to the SharePoint Server 2007 
tools designed to assist in group collaboration. These resources are usually 
lists, such as contact lists and task lists, but they can also be calendars, or

y
members to update the SharePoint server with 
changes, as necessary.

Discussion 
Board

Use Discussion Boards to discuss specific topics 
during the course of a project. While e-mail 
discussions require participants to find and sort many 
messages Discussion Boards isolate messages forlists, such as contact lists and task lists, but they can also be calendars, or 

documents in progress.

There are five types of resources that can be used in Outlook 2007:
• Calendar
• Task List
• Document Library
• Discussion Board

messages, Discussion Boards isolate messages for 
easy tracking. 

Contact List Use Contact Lists to stay in touch with other team 
members and with important people outside the 
team. And as one member adds contacts to a list or 
edits it, the entire team gets the new information.

• Discussion Board 
• Contact List

See the following table for descriptions of these resources.

Consider what resources your project needs and then add them to your 
SharePoint Server 2007 site. After you connect them to your own Outlook 
2007 mailbox, you can share them with others.
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Connecting Outlook 2007and SharePoint 
Server 2007
It’s easy to connect resources to Outlook 2007 and then share the 

To share your connection with others, go to a SharePoint Server 2007 folder 
in the Mail pane, right-click the folder, and then click Share [resource 
name]. In the message window that appears, send invitations to share the 
resources.

connection with others. After creating a resource on a site—for example, a 
task list or a calendar—go to the resource and, on the Actions menu, click 
Connect to Outlook.

When the connection is made, the resources appear as folders in your 
Outlook 2007 mailbox. The folders are listed in the Mail pane under 
SharePoint Lists. SharePoint calendars do not appear as folders. Instead, 
they appear with other calendars in the Calendar pane.

To accept an invitation and connect to the same resources in Outlook 2007, 
invitees click a button in the message. 

After connecting to the resources invitees can begin collaborating with theAfter connecting to the resources, invitees can begin collaborating with the 
resources in Outlook 2007.
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Online and Offline
To get the greatest benefit from working in Outlook 2007 and SharePoint 
Server 2007, it helps to understand the difference between the online and 

• Documents you have edited but not yet updated can be found inside 
your SharePoint Drafts Search Folder.

offline synchronization experiences. 

When you 
are online

Edits made in Outlook 2007 to resources are 
automatically synchronized with the master files on the 
SharePoint Server 2007 site. These changes are 
synchronized with those made by others who share the 
connection in Outlook 2007connection in Outlook 2007.

When you 
are offline

You can view and edit cached versions of resources, but 
your edits are not synchronized with the master files on 
the SharePoint Server 2007 site, and not synchronized 
with those made by others until you go online. Go online 
periodically to trigger synchronization.

Notes

Tip  To prevent the loss of information when more than one person is 
working on a document at the same time, turn on version control at the 
SharePoint Server 2007 site, or check out the document before you begin 
working on it.

• When editing documents, you must first make a local copy of the 
document, edit it offline, and then manually synchronize your changes 
with the SharePoint site. You will be prompted to do so.
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Microsoft® Office Outlook® 2007 enables you to manage your time by 
separating your personal and business calendars, and allowing you to 
i h i F l fi d i f l

In the Name box, type a name for the new calendar, and then click 
OK. 

3

The calendar name and a check box 
appear under My Calendars Repeat thisview them at one time. For example, you may find it useful to separate 

your personal appointments from business appointments by creating 
two different calendars. Also, if you schedule projects or team events 
in the calendar on a Microsoft® SharePoint Server 2007 site, you can 
connect this calendar to Outlook 2007. 

With Outlook 2007 using multiple calendars is efficient—you can view

appear under My Calendars. Repeat this 
process to create additional calendars.

• Create Additional Calendars
• Connect to SharePoint Server 2007 Calendars in Outlook 2007
• View Multiple Calendars

With Outlook 2007, using multiple calendars is efficient you can view 
and use the calendars individually or together. Connect to SharePoint Server 2007 

Calendars in Outlook 2007
View and use calendars from both programs in Outlook 2007. For example, 
if your team uses a calendar on a Team Site to track vacations, you may 
want to view this calendar in Outlook 2007 when scheduling team meetings 

t

Topics in this guide include: 

• Move Appointments between Calendars

Create Additional Calendars Important  A calendar on a SharePoint Server 2007 site is required to 

or events. 

View and work with the calendar from either Outlook 2007 or from the 
SharePoint Server 2007 site. Because the two calendars are linked, any 
changes you make are saved in both calendars.

In the Outlook 2007 navigation pane, click Calendar. 1

p q
complete this procedure. 

Under My Calendars, right-click 
Calendar, and then click New Folder. 

2

Navigate to a calendar on a SharePoint Server 2007 site. 1
Click Actions, and then click 
Connect to Outlook. In the 
Microsoft Office Outlook dialog

2
Microsoft Office Outlook dialog 
box, click Yes. The calendar from 
the site will appear next to your 
other calendars in Outlook 2007. 
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View Multiple Calendars
There are three ways to view your calendars: one at a time, side by side, or 
overlaid on top of each other. Whichever view you use, you can move 
calendar items between the calendars and create or delete items on the 
calendars

As you select calendars, they appear side-by-side in the main window. To 
close a calendar, clear its check box. 

calendars.    

One-at-a-Time View

After adding additional calendars, there may be times when you want to 
view just one of the calendars. 

In the Outlook 2007 navigation pane, click Calendar.1
Under My Calendars, clear all the check 
boxes except the one next to the calendar 
you want to view.

2

Side-by-Side View
Side-by-side viewing is ideal for moving appointments between calendars. 

Tip  To create more viewing room on your screen, collapse the left 
navigation pane or the To-Do Bar. To collapse one of these, go to the top of 
the left navigation pane or the top of the To-Do Bar, and then click the 
arrow. To expand the pane, click the arrow again.

In the Outlook 2007 navigation pane, click Calendar.1

Under My Calendars, select the check 
box next to each calendar you want to 
view.

2

p p , g

To-Do BarNavigation Pane
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Overlay View
Overlay view is ideal for identifying scheduling conflicts. By using a 
transparent overlay with color-coded calendar items overlay view allowstransparent overlay with color coded calendar items, overlay view allows 
you to see all your meetings as if they are on one calendar. 

In the Office Outlook navigation pane, click Calendar.1
Under My Calendars, select the check 
b t t h l d t t

2
box next to each calendar you want to 
overlay. The calendars appear side-by-
side.

On the tab of any calendar you want to overlay, click the arrow. As you 
click the tab arrows of various calendars, the calendars overlay across 
each other. 

3
Tips
• To bring a calendar to the front, click the calendar tab or an g ,

appointment.
• To move a calendar back to side-by-side view, click the tab arrow.
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If you no longer need a calendar, remove it. 

Under My Calendars right-click the name of the calendar you want to1

Delete a Calendar
Moving appointments keeps them attached to specific calendars, and 
prevents others from seeing personal items. For example, if you move 
personal appointments to secondary calendars they cannot be shared with

Move Appointments between Calendars

Open two or more calendars in side-by-side view.1
To mo e o cop appointments do one of the follo ing2

Under My Calendars, right-click the name of the calendar you want to 
remove.

1

Click Delete [calendar name].2

Note  Your main calendar cannot be removed.

personal appointments to secondary calendars they cannot be shared with 
others because only your main (default) calendar or calendars from 
SharePoint Server 2007 sites can be shared. 

To move an appointment, right-click it, click Cut, and then paste it on 
the other calendar. 

–OR–

T i i h li k i li k C d h i

To move or copy appointments, do one of the following:2
Restore a Calendar

Restore a Calendar Created in Outlook 2007

The way you restore a calendar depends on where the calendar was 
created.

To copy an appointment, right-click it, click Copy, and then paste it on 
the other calendar. 

Note  Single occurrences of an appointment series cannot be moved to 
another calendar; however, you can copy a single occurrence. To move an 
entire appointment series, you must move the first meeting in the series.

From the Go menu, click Folder List. In the Folder List, expand the 
Deleted Items folder. 

Drag the calendar from the Deleted Items folder to the Calendar 
folder.

1

2

If you mistakenly remove a SharePoint Server 2007 calendar from Outlook 
2007, restore it by going to the site and reconnecting the calendar. For 
d t il th “C t t Sh P i t C l d i O tl k” t i li i

Restore a SharePoint Server 2007 Calendar

Note If the calendar no longer exists in the Deleted Items folder, it is 
permanently deleted and cannot be restored.

details, see the “Connect to SharePoint Calendars in Outlook” topic earlier in 
this guide. 
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Add a Second Time Zone to a Calendar
If you work with people in other geographic locations, adding a second time 
zone to your calendar can help you manage the time differenceszone to your calendar can help you manage the time differences.

On the Tools menu, click Options.1

Under Calendar, click Calendar Options. 2

Select the Show an additional time zone check box.4

In the Label box, type a description, such as “Tokyo.” 5

Under Advanced options, click Time Zone.3

Tip When you enter the area with a different time zone, you can use the 
secondary time zone as your main calendar time by going into 

In the Time zone list, click the time zone, and then click OK. The 
second time zone appears next to your default time zone.

6

Tools>Options>Calendar Options>Time Zone. In the Time Zone
dialog box, click Swap Time Zones. This syncs all your calendar items with 
the new time zone. To switch back, click Swap Time Zones again. 
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To-Do Bar Task List
Includes flagged 
e-mail messages, 

Tasks in the Microsoft Office system are similar to a to-do list. Tasks 
make it easy to use Microsoft® Office Outlook® 2007 to organize your 
time and your work. Tasks are integrated across Outlook 2007, 
Microsoft® Office SharePoint® Server 2007, and Microsoft® Office 
OneNote® 2007—enabling you to smoothly work between applications.

T i i thi id i l d

tasks, and 
downloaded 
SharePoint Server 
2007 tasks.

• About the To-Do Bar in Outlook 2007
• Create a Task in Outlook 2007
• Flag Incoming E-Mail Messages for Follow-Up
• Attach Files and E-Mail Messages to a Task
• Use Outlook 2007 to Work with SharePoint Server 2007 Tasks
• Create an Outlook 2007 Task from Microsoft® Office OneNote®

Topics in this guide include:

• Create an Outlook 2007 Task from Microsoft® Office OneNote®
2007

About the To-Do Bar in Outlook 2007
The To-Do Bar includes calendar and task information. Tasks include regular 
tasks in the task folder and e-mail messages flagged for follow up. 

Most of the procedures in this guide use the To-Do Bar. If the To-Do Bar is 
not displayed on your screen, go to the View menu, point to To-Do Bar, 
and then click Normal.

Daily Task List Displayed in Calendar 
Completed tasks stay on the day of completion in your calendar and are 
recorded as work performed on that day. Tasks not completed move on to 
the next day until they are completed.
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On the To-Do Bar in the Type a new1

Create a Task In Outlook 2007 To add a specific start date, due date, reminder, or any additional 
information, double-click the task in the To-Do Bar Task List. Make 
changes in the task window, and then click Save & Close. 

2

On the To Do Bar, in the Type a new 
task box, type the name of the new task, 
and then press ENTER to complete 
creating your task. 

The task appears in the To-Do Bar Task 
List with a default due date of the current 

1

date.

Tip  To create a task from an Outlook 2007 item, drag the item (such as an
e-mail message, contact, or calendar event) onto the Task List in the To-Do 
Bar. 

Note If the Type a new task box does not appear, on the To-Do Bar 
Task List, right-click the Arrange By bar, click Custom, and then click 
Reset Current View. Click OK.

Apptix Live Support: 866-688-0128   Online Support:  http://hostaccount.custhelp.com



SharePoint Integration How To’s / Tasks  (Advanced )| 3 of  8

Schedule Time for an Outlook 2007 Task 
Schedule time in your Outlook 2007 Calendar to work on a task, or schedule 
a meeting to talk about a task.

Flag Incoming E-Mail Messages for Follow-Up
Use flags to add an incoming e-mail message to the Tasks list. When you 
flag an e-mail message, it appears in the Daily Tasks List in the Calendar 
and in the To Do Bar Task List

On the Outlook navigation pane, click Calendar. 

Drag the task you want to schedule time for from the To-Do Bar Task 
List to the Calendar. 

2

and in the To-Do Bar Task List.  

Right-click the flag icon on an unopened e-mail message.

Click the flag with the preferred due date. To choose specific start dates 
and due dates, click Custom.

1

2

1

Tips

Double-click the calendar appointment you created. On the 
Appointment tab, select the options you want, and then click Save & 
Close.

3

• To apply the default flag (Today), click the flag icon on the e-mail 
message. To mark the task complete, click the flag again and a check 
mark appears.

• To change the default flag, click the flag icon on the e-mail message, and 
then click Set Quick Click. 
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Flag Outgoing E-Mail Messages as a Reminder
To remind yourself to follow up on e-mail messages you’re sending, add 
flags when you send e-mail messages.  

Attach Files and E-Mail Messages to a Task
Attach related files and e-mail messages to a task—task-related content is 
conveniently located in one place. g y g

Note  When you flag e-mail messages, the flags are only viewable by you—
unless you specifically set a flag for the recipients as well.

Create a new e-mail message.1

co e e t y ocated o e p ace

Open a task.

Note This procedure will not work with flagged e-mail messages. To 
make sure you actually opened a task, the window must be labeled with 
“[Task Name] - Task” at the top and include a Task tab

1

On the Ribbon, on the Message tab, click Follow Up, and then click 
the time on which you want to follow up. 

2
[Task Name] - Task  at the top and include a Task tab.  

Select the file or e-mail message, and then drag it into the Task
window. 

Tip You may need to resize your windows to drag items into the Task
window

2

window.

Notes
• If you want to also set a flag for the recipients, click Follow Up, and 

then click Flag for Recipients.
• To set a specific date for follow up, click Custom, and then click a dateTo set a specific date for follow up, click Custom, and then click a date 

that you want.

Click Save & Close. 3
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Mark a Task Complete
• On the To-Do Bar Task List, right-

click the flag to the right of the task, 
d th li k M k C l t

Use Outlook 2007 to Work with SharePoint 
Server 2007 Tasks
With Outlook 2007 you can now view and change tasks that exist on yourand then click Mark Complete. 

The task no longer appears in the 
To-Do Bar Task list and appears as 
complete in the tasks To-Do List. 

With Outlook 2007, you can now view and change tasks that exist on your 
Team Site. Any changes that you make to tasks in Outlook 2007 are 
automatically synchronized with SharePoint Server 2007.

To use Outlook 2007 to view and edit SharePoint Server 2007 tasks, you 
must connect Outlook 2007 to the SharePoint Server 2007 Task list. After 
you do, the SharePoint Server 2007 tasks appear in your Outlook 2007 
Tasks list

Tips

• To mark a task complete, right-click 
on the task and then click Mark
Complete. Or in the Outlook 
navigation pane, click Tasks, and 
then select the check box to the left

Tasks list.

Note Working with SharePoint Server 2007 tasks in Outlook 2007 requires 
a SharePoint Server 2007 site. 

then select the check box to the left 
of the task.

• To delete a task, click Tasks in the 
Outlook navigation pane, right-click 
the task, and then click Delete. 
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Notes

• If you receive a task e-mail 
message from a SharePoint 
2007 site, you can 
automatically connect Outlook

Connect Outlook 2007 to a SharePoint 
Server 2007 Task List

automatically connect Outlook 
2007 to a SharePoint 2007 
Task list. See the next topic, 
“Respond to a Task E-Mail 
Message from a SharePoint 
Server 2007 Site.”

As with any SharePoint Server

On a Team Site or My Site, in the left navigation pane under Lists, click 
Tasks.

1

2 On the menu bar, click Actions, 
and then click Connect to 
Outlook. In the Microsoft 

• As with any SharePoint Server 
2007 site, you need the proper 
permissions to view, edit, add, 
and delete items. If you do not 
have the correct permissions to 
the SharePoint Server 2007 
task list, you need to request

Office Outlook dialog box, 
click Yes.

All tasks are now added to your 
Outlook 2007 Tasks List. Only 
the tasks assigned to you are 
displayed in the To Do Bar task task list, you need to request 

access from the site 
administrator.

Outlook Tasks List

displayed in the To-Do Bar task 
list and the Daily Task List.

Repeat the procedure above for 
each SharePoint Server 2007 
Task List you want to connect 
to Outlook 2007.

Respond to a Task E-Mail Message from a 
SharePoint Site
When you receive a task e-mail message from a SharePoint Server 2007 site 
in your inbox, you can add the task to your Outlook 2007 task list. When 
you add the task Outlook 2007 automatically creates a connection to the

to Outlook 2007.

you add the task, Outlook 2007 automatically creates a connection to the 
SharePoint 2007 Task List. All the tasks in the SharePoint 2007 Task List will 
be displayed and synchronized in your Outlook 2007 Task List. 

Only the tasks assigned to you that you received in your inbox are displayed 
in the To-Do Bar Task List and the Daily Task List.
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• In the reading pane of Outlook 2007, in the SharePoint Server 2007 task 
e-mail message, click View and Synchronize ‘[Task List Name]’ list.   

Use Outlook 2007 to Create SharePoint 
Server 2007 Tasks 
You can create and assign tasks from Outlook 2007 to a SharePoint ServerYou can create and assign tasks from Outlook 2007 to a SharePoint Server 
2007 task list. This allows you to use Outlook 2007 to manage tasks that 
exist on a SharePoint Server 2007 site.

Note To complete the procedure below, you must be connected to a 
SharePoint Server 2007 task list. See “Connect Outlook to a SharePoint 
Server 2007 Task List” earlier in this guide.

In the All Task Items
section, under Other Tasks, 
click the SharePoint site 

2

On the Outlook 2007 navigation pane, click Tasks. 1

c c t e S a e o t s te
where your tasks reside. 

On the File menu, point to New, and then click Task.3

After you click the link, the task on the SharePoint Server 2007 site is added 
to your To-Do Bar task list. A folder with the SharePoint Server 2007 Task 
List name also appears under Other Tasks in the tasks navigation pane.

Note  To opt-out of receiving SharePoint Server 2007 Tasks in Outlook 
2007 click Modify Notification Settings in the body of the SharePoint

In the task window, add a specific start date, due date, any additional 
information, or assign the task, and then click Save & Close. Any 
changes made to the task in Outlook are saved to the SharePoint tasks 
list. 

3

4

Note Only the tasks assigned to you are displayed in the To-Do Bar task

2007, click Modify Notification Settings in the body of the SharePoint 
Server 2007 task e-mail message. 

Note Only the tasks assigned to you are displayed in the To Do Bar task 
list and the Daily Task List. 
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To add task details in 
OneNote 2007, right-click 
the flag, and then click 
Open Task in Outlook,
-OR-

3Create an Outlook 2007 Task from OneNote 
2007
Create Outlook 2007 tasks using OneNote 2007, and then view and manage 
th t k i O tl k 2007 Ch k t th t k i O tl k OR

To add task details in 
Outlook 2007, double-
click the task in the To-
Do Bar task list. 

the tasks using Outlook 2007. Changes you make to these tasks in Outlook 
2007 or OneNote 2007 are synchronized automatically. 

Click the note to which you would like to add a task.1

In the task window, add a 
reminder, any additional 
information, specific start 
or due dates, or assign 
the task, and then click 
Save & Close

4

Save & Close.

The task is now in your 
OneNote 2007 notes and 
Outlook 2007 To-Do BarOn the Insert menu, point to Outlook Task, and then click a flag. The 

flagged task now appears in Outlook 2007 on the task list and the To-
Do Bar Task List

2 task list. You can manage the task using Outlook 2007.

Notes

• Make minor changes to the task in OneNote 2007 without opening the 
task in Outlook 2007. In OneNote 2007, right-click the flag next to the 
note, and then click a flag, mark the task complete, or delete the task. 
The change is automatically saved in Outlook 2007. To make more 
d t il d h th t k i O tl k 2007 d ib d li i

Do Bar Task List.

detailed changes, open the task in Outlook 2007 as described earlier in 
this guide.

• To go from the open task in Outlook 2007 to the OneNote 2007 page 
where the task resides, double-click the OneNote 2007 icon in the task 
body. See the image earlier in this guide. 
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